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[bookmark: _Toc316480823][bookmark: _Toc316480905][bookmark: _Toc352231992]Preface
What does it take to move to Bentley Civil V8i SELECTseries3?  What steps do you follow?  What is the impact to standards, as well as to managers and end users? This workshop will attempt to answer those questions in a way that will assist organizations in their movement from SELECTseries 2 to SELECTseries 3 functionality. From importing existing feature definitions to the establishment of horizontal and vertical design standards, we have structured the contents of the exercises to allow your interaction with as broad a range of topics as possible.  While we may not be able to cover every workflow and possible configuration issue that may be encountered within an organization, we will cover the ‘major’ topics that we feel most organizations will confront. 
This workshop is equally applicable for the MX, InRoads or GEOPAK families of products.  The majority of topics and exercises are common to all three product lines.  Where differences do occur such as in the importing of existing feature definitions, we will point those differences out and accommodate them within the exercises themselves.  
There are more exercises in this manual than we will have time to cover today.  We will all complete the basic set of exercises, and for those veteran users in the group who complete them and still have time left in the exercise session, you are welcome to work on the optional.  In addition, the workshop guide and dataset is yours to take with you.  If you don’t finish all the exercises, or just want to work with the dataset upon return to your office, the datasets (both initial and completed files) are provided on the Conference DVD.  Many workshops will also have videos of all exercises on the DVD.  
Note: Prerequisite Knowledge Level: Participant should have a basic understanding of civil design and the types of workspace configurations that they require. For example, features, configuration variables, seed files, workspace preferences, etc. They should also be fluent in the use of one of the Bentley Power products or CAD and the native application (MX, InRoads or GEOPAK). 


[bookmark: _Toc349908215][bookmark: _Toc352231993]Session Description
What does it take to move to SELECTseries3? What steps do you follow? What is the impact to users, to standards, and to you? This hands-on workshop provides instruction for CAD managers and others   for moving their GEOPAK users and standards forward to SELECTseries 3.  This workshop is targeted for all intermediate Bentley civil users.
[bookmark: _Toc349908216][bookmark: _Toc352231994]Learning Objectives
After this course you will be able to:
Set up seed files with the desired civil preferences and settings.
Link civil features to legacy settings 
Review and work with Civil Features
Understand how to use DGN Libraries to setup and control civil standards and settings.
At the end of this training session, an assessment will be given. We will review all assessment questions and answers to see what you have learned.
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[bookmark: _Toc352231995][bookmark: _Toc316905056]Chapter 1:  Moving From SELECTseries2 to SELECTseries 3
[bookmark: _Toc352231996]Overview
Bentley Civil software has been integral in the development of the world’s infrastructure for the last 3 decades through the GEOPAK, InRoads and MX product lines. The products and tools themselves have been developed in conjunction with practitioners from around the world to reflect best practices that are both tried and tested. However, aging infrastructure along with economic and legislative influences now require a shift in philosophy that places an increased demand on project delivery for greater efficiency, accountability and sustainable designs. This paradigm shift in project delivery requires an evolution in tools and practices. 
With this in mind, the V8i SELECTseries 3 release will be a significant milestone for the Bentley Civil product line. By taking advantage of the benefits offered through technological advances, this release will address the aforementioned project delivery needs by facilitating greater productivity in the design processes, reduced delivery times and distributed team management to aid in the provision of sustainable designs.
The V8i SELECTseries 3 release of Bentley Civil software contains not just new tools but new technology.  Developed in line with changes in philosophy to harness the latest hardware and software developments, it integrates CAD and engineering knowledge to create a ‘Better Model’ that can be used throughout the assets lifecycle and address market requirements. 
[bookmark: _Toc304557601]The new and enhanced technology inherent in the V8i SELECTseries 3 release provides us an opportunity to change our philosophy of project deliverables. A user can design a project and not be limited to producing only a traditional paper plan set, but actually produce a deliverable containing an intelligent spatial model. This model can then be utilized downstream of the design not only for project planning and construction, but also throughout the assets life cycle. As with any new release of software, users will of course need to become familiar with enhancements and new technologies. However, the larger issue here is the shift away from a mindset of producing plans to a philosophy of producing an intelligent model, in effect a move to a model-centric design process.
[bookmark: _Toc352231997]What Do We Mean By Model-Centric?
Simply put, a Model-Centric approach facilitates the use of a common data repository that can be used collaboratively throughout the lifecycle by the various interested parties without the need for replication or duplication of data.
The V8i SELECTseries 3 release of Bentley Civil software uses at its core the DGN model. In other words, all civil artifacts such as geometry and surfaces reside in the DGN model. This provides the user multiple benefits.
The DGN model provides a readily consumable graphical format that is open source and accessible through many viewers (Navigator, DWG, 3D PDF, etc.). 
Currently, in many cases, civil data must be essentially converted and in some cases requires reverse engineering to be conformed to a usable format that can be used by other disciplines and/or software. Being able to view and analyze the information directly in the DGN model reduces the error prone process of conversion and reduces lead in time. 
Civil software has progressed from a simple drafting toolset, to more sophisticated drawing capabilities, to design, survey, hydraulics and other functionally specific toolsets as adjuncts.  With advances in technology in the last decade (both hardware and software for design and construction), we have an opportunity to move from adjuncts to integration; a Civil software solution where users can perform workflows efficiently, with the results perpetuated throughout the project.
[bookmark: _Toc320022710][bookmark: _Toc352231998]Data  Sharing vs. File Sharing
As we mentioned earlier, with traditional projects that utilize external proprietary databases and formats, it is a common requirement that project information is provided to external sources (such as a contractor, consultant, clients, etc.) who may not utilize the same software in which the data was created. In addition, a typical civil project is comprised of numerous disciplines needing to share data as well (e.g. survey, civil, structural, hydraulic, geological, etc.). 
The data on a civil project typically include a variety of formats covering multiple disciplines. This includes traditional CAD design files that are interconnected via reference files. In addition, a variety of auxiliary files exist that pertain to various aspects of the project.  Examples include files for existing and proposed terrain models as well as files that pertain to roadway and structural components, survey, ponds, park and rides, geotechnical databases and hydraulic files, just to name a few. 
However, with V8i SELECTseries 3, the fundamental shift from file sharing to data sharing has begun with the elimination of proprietary files and specialized formats. For example, the terrain model moves out of a proprietary, binary formatted file and into a DGN Model as a MicroStation element that can be referenced to any other design file. Horizontal and vertical geometry also move out of proprietary databases and into a DGN model. The tools draw “smart” geometric graphics which enable easy modification and manipulation and can be targeted and consumed by other civil tools. Finally, the proposed surface model itself moves out of a propriety formatted file and into the DGN model, allowing for the first time the cutting of dynamic sections directly from 3D elements. 
[bookmark: _Toc320022711][bookmark: _Toc352231999]Using the Design File As a Container For Data 
By shifting the storage of data from historical proprietary external data files into a common openly accessible design file, the typical issues encountered with traditional file sharing diminish.  However the data still needs to be managed and shared with both internal and external parties in an efficient manner. Some parties need only consume the data, so that viewing capabilities are the only requirement.  Other parties need to interact and in some cases modify the data.  The use case for data sharing need to be considered to ensure project team members have the ability to modify data, without infringing on other team members.  Topics including how to avoid any accidental deletion or modification of data are also warranted.  While current workflows have accounted for these scenarios, they need to be revisited as the technology and Civil solutions change. 
The container methodology also enables review and packaging of a project for external partners or management review.  It can be utilized within ProjectWise or in a Windows environment.
The container methodology will accomplish several objectives:
Other project team members have the data readily accessible.
Project team members only go to one location as a source of data.
Project team members can update the data as needed in a centralized location.
When using reference files, files can be read only which avoids accidental deletion.
[bookmark: _Toc320022721][bookmark: _Toc352232000]
SELECTseries 2 and SELECTseries 3 Workflows
From a high-level perspective, the following workflow is common for SELECTseries 2. 


As it is a high-level perspective, each major grouping may be handled by multiple units within your organization.  For example, the Survey / Mapping functions in your organization may be done by a single unit, or multiple groups, or outside your organization.  The overall Design functions may be handled by Design, Hydraulics, Right-of-way, Traffic and a myriad of groups all involved in project delivery.


[bookmark: _Toc352232001]SELECTseries 3
In SELECTseries 3, the groups in white do not have workflow changes, while those in green will see an impact. 

The tool set provided at SELECTseries 3 provides all Bentley Civil products with MicroStation integrated capability and significant productivity gains in the following areas: 
New terrain modeling tools that extend the native MicroStation terrain element, providing additional creation, analytical and editing capabilities required by civil workflows. Along with these new functionalities, the user will see significant performance improvements in handling not only much larger terrains, but in displaying and manipulating those terrains as well. Finally, a wider variety of data file formats will be supported than those found in earlier versions.
New civil geometry tools that provide ‘object modeling’ design capabilities for both horizontal and vertical methodologies. These new capabilities give the user the ability to establish rules and relationships between multiple geometric elements, allowing geometry elements to update automatically as changes are made within these relationships. In addition, a new user experience allows for heads up design and editing capabilities.  Finally, integration of geometric design standards allows for the population of standards values based on design speeds as well as for immediate error checking and flagging.
Enhanced modeling technology that provides for integrated, dynamic and real time modeling of corridor components, surface models and resulting geometry.  An enhanced model that facilitates better quantities and easier visualization as well as construction simulation and asset management.
In addition to new technology and advancements in the tools sets mentioned previously, traditional workflows will benefit with the implementation of the following important milestones:
A shift in the design process with a focus on data sharing. Traditional workflows depend greatly on file sharing. However, data sharing reduces design errors in multi-disciplined, distributed workflows and provides ease of design review. 
The preservation of a user’s design intent provides automatic, intelligent updating of the models and facilitates reduced delivery times as well as reduced potential for errors.
A new user experience provides for design environment enhancements through an intuitive and dynamic interface.
[bookmark: _Toc352232002]Survey / Mapping
The Survey and Mapping functions will see no changes in the data collection, but will have improvements in processing.  The Mapping functions have new and improved tools for Point Clouds, and improved terrain model functionality. 


Changes to the workflows include:
Easier processing via drag and drop of data files into Project
Graphical editing of data
Optional audit trail
Benefits to these workflows include:
Survey field collection – easier editing capabilities
Easier hand-off to downstream customers
All information is stored in the DGN file
Improved terrain model
Ability to handle more formats
Better reporting
[bookmark: _Toc352232003]Planning 
	As Permitting and Environmental processes are normally not CAD intensive, there is no significant change to the workflows.  
There are also significant gains to be made by expanding into areas that have historically not been CAD intensive.  The interactive geometry provides immediate visual feedback, especially when utilizing Design Standards. 
Now alternatives can be developed quicker and to a higher quality than ever before with Corridor Modeling.  These alternatives can be easily referenced and enhanced by downstream customers in Design, Hydraulics, and other functional groups.  This may blur the lines between Planning and Design functions.  
Changes to the workflows include:
Interactive, rules-based horizontal and vertical geometry
Corridor Model
Benefits to these workflows include:
Easier hand-off to downstream customers
All information is stored in the DGN file
Improved terrain model
Quicker development of alternates


	








[bookmark: _Toc352232004]Design
The dramatic upgrades to the Design process include Geometry and Corridor Modeling, Design Intent and automatic, intelligent updating.  The 3D Information Model in early stages is the Corridor Model, expanding as organizational needs and resources determine the time frame and level of data information. 


[bookmark: _Toc295924320]Design Intent
Design intent is the preservation of the rules, relationships and decisions made during the design process. By capturing the intent at its inception, the software can utilize the intent for more intelligent updates, all the while checking against organizational standards.  
[bookmark: _Toc295924321]Automatic, Intelligent Updating
One common problem encountered throughout the design process is when a change is made in one aspect of the project (such as changing a horizontal curve on an alignment), but the designer neglects to carry that change throughout the project.  This example would require changes to plan view elements (such as moving edges of pavements and shoulders) and a reprocessing of 3D modeling.  In addition, the change in curve may have violated the Design Speed of the project.  In SELECTseries 3, the designer can make the alignment modification graphically, which is automatically (but intelligently) reflected in the associated plan view graphics which adjusts the 3D model.

Changes to the workflows include:
Interactive, rules-based horizontal and vertical geometry
Corridor Model 
Design Standards (horizontal and vertical geometry, superelevation)
Benefits to these workflows include:
Easier hand-off to downstream customers
All information is stored in the DGN file, with robust support for reference files
Improved terrain model


[bookmark: _Toc352232005]Beyond SELECTseries 3 – Civil Information Model



Within the Civil arena, the model is expanding well beyond Design.  It encompasses a wide range of functional areas and data information.  This expansion is not unique to the user base.  Development in Bridge and Subsurface Utility Design and Analysis (SUDA) is ongoing, even before the SELECTseries 3 release, much of the work built on the OpenRoads technology. 




[bookmark: _Toc352232006]Evolution of Civil Model to Information Mobility
As we move beyond SELECTseries 3, requirements for information mobility will drive all the processes to evolve and draw down on the benefits the 3D model provides throughout a projects lifecycle.  
Bentley’s i-model delivers information mobility, coupled with Projectwise makes true interdisciplinary collaboration a reality throughout a project’s lifecycle, ensuring the same information is used by the right people at the right time.
[image: ]



[bookmark: _Toc352232007]How to Transition From SELECTseries 2 to SELECTseries 3
Transitioning from SELECTseries 2 to SELECTseries 3 can be done in a variety of different methods, based on resources, software utilization, and organizational structure.  These include:
Complete enterprise-wide deployment
Enterprise-wide deployment but based on geographic locations stretched out over a period of time
Deployment based on functional group (i.e., surveys, planning, design, hydraulics, etc.)
Deployment based on projects (as new projects are started, begin them in SELECTseries 3)
No deployment
[bookmark: _Toc352232008]SELECTseries 2  or SELECTseries 3 or Both?
While doing advance preparation and testing, both SELECTseries 2 to SELECTseries 3 can be installed on the same workstation or laptop.  In this way, user support can still be provided for the current software, while testing and set-up is being done.
However, for production, you may want to have only SELECTseries 3 installed.  The reasoning is that all the tools currently in SELECTseries 2 are still available in SELECTseries 3.  In addition, you have all the new and upgrade tools available at the same time.  
[bookmark: _Toc352232009]Installation
The installation of any Bentley Civil product is time-consuming, due to sheer size.  This has been identified as a major roadblock to deployment, as many organizations are decentralized and have numerous locations where computers need to be loaded.  SELECTseries 3 is a complete build, not a service pack or patch.  But the good news is that once you have SELECTseries 3 installed, all subsequent installs will be “patch technology” which will dramatically decrease the size of installation packages.  The patches are cumulative, meaning that a patch has all the patches issues since the baseline release.  
[bookmark: _Toc352232010]Advance Preparation
The changes and new features in V8i SELECTseries3 will require careful planning and preparation.  However, many of the tasks can be completed and deployed prior to the actual deployment.  In this manner, the system set-up and testing work can be spread out over time, and minimize the impact during actual deployment.  
Review current MicroStation resources – are they in DGNLibs or can they go there?  How are XIN, DDBs and PSS affected?
Development of MicroStation element templates (such as for terrain models)
Review design standards – validate local standards.
Review Design File Settings within Seed Files – Determine default settings for Civil Formatting
Review Workspace Preferences – View Options > Civil
Superelevation tables – do you have your standards currently set up and in production?
New configuration variables – which will be utilized and how to be incorporated?
Review reports; determine defaults, deficiencies
Do you want to create an enterprise-wide or functional group customized task navigator?
Review new workflows and determine which areas may be moved forward to new methods.
 Are there any customized workflows that need to be integrated?
[bookmark: _Toc352232011]Chapter Summary
Now that we have reviewed some of the aspects of moving, let’s look at how we address some of these tasks.
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[bookmark: _Toc352232012]Chapter 2:	Workspace Configuration 
[bookmark: _Toc316480828][bookmark: _Toc316480910][bookmark: _Toc316905057][bookmark: _Toc352232013]Overview
An important part of being able to control your standards and preferences within an organization is the use of configuration variables. Bentley Civil V8i SELECTseries3 contains several new configuration variables that allow you to control such items as the location of preferences to the specifics of a design tool.
[bookmark: _Toc316480912][bookmark: _Toc316905059][bookmark: _Toc352232014]New Configuration Variables  
First, let’s look at a complete list of the new Civil configuration variables in SELECTseries 3 with a brief description of each one. Not all of these variables will be set or even used in today’s workshop, but they are all listed here for your convenience.

	Configuration Variable
	Description

	CIVIL_SHOW_MS_PROPERTIES
	Display extra MS properties that are normally hidden on civil elements.

	CIVIL_STOP_COMMAND_DEFAULTS
	This stops the Civil commands storing their defaults as xml. Mainly used for automated testing. Existing files will have to be deleted as it does not stop the system reading them.

	CIVIL_DISALLOW_LOCKCHANGES
	If set to a value of 1, disallows any lock changes to existing rules. This variable prevents a locked rule from being unlocked or an unlocked rule from being locked.

	CIVIL_SUPERELEVATION_RULES_DIRECTORY
	Defines the directory to be used as the default location for superelevation preference (SEP/SR) files.

	CIVIL_DEFAULTSETTINGS
	Used to locate the folder holding the XML file that includes the Civil AccuDraw defaults.

	CIVIL_DEFAULT_LINEAR_STROKING
	Defines how often to compute a point or template drop interval location on a tangent segment. This variable is not used by Corridor Modeling. If not set, the value defaults to 10. This is used when generating 3d elements and the Apply Template command.

	CIVIL_DEFAULT_PROFILE_STROKING
	Defines how often to compute a point or template drop interval location along a profile, with extra points being computed based on a chord offset from the profile. The value defines the chord height used to calculate the extra points. If not set, the value defaults to 0.1. This is used in Corridor Modeling when Vertical Curve Densification is applied.

	CIVIL_DEFAULT_CURVE_STROKING
	Defines how often to compute a point or template drop interval location along a curve segment with extra points being computed based on the chord offset from the horizontal curve. The value defines the chord height used to calculate the extra points. If not set, the value defaults to 0.01. This is used in Corridor Modeling when Horizontal Curve Densification is applied.

	CIVIL_DEFAULT_STATION_LOCK
	If set to 'true', stations for various commands are calculated and kept at even numbers. For example, template drops would always fall on even stations in the event of an equation that could cause it to do otherwise. If not set or set to 'false', the station values will be maintained at the specified increments.

	CIVIL_DISALLOW_REFERENCEDELETIONS
	If set to a value of 1, does not allow an element to be deleted if that element is referenced by another. Does not work across reference files.

	CIVIL_ROADWAY_TEMPLATE_LIBRARY
	Defines the default template library (ITL).

	CIVIL_XIN_FILE
	Defines the default XIN file. (InRoads only).

	CIVIL_CIVILSETTINGS_READONLY
	If set to a value of 1, all standards, preferences, or features that come from a DGN Library are persisted as read-only in the active file.

	CIVIL_SURVEY_DISABLE_DIVIDE_BY_TWELVE
	If set to a value of 1, this variable indicates that the sizes read from a GEOPAK SMD XML file should not be divided by 12 when linked into survey feature definitions. Applicable for GEOPAK XML SMD files in an English environment only.

	CIVIL_SURVEY_ELEVATION_POSITION_FIVE_ANGLE
	If set to a value of 1, allows the elevation annotation to be rotated by the angle specified when the label position is set to position 5. (GEOPAK XML SMD only)

	CIVIL_SURVEY_APPLY_STYLE_FILE_LINE_STYLE_SCALE
	If set to a value of 1, this variable allows Custom Line Styles to be SCALED by the value placed in the Style file. Example, the Line Scale in the SMD has several options, Apply Plot Scale, Apply Plot Scale times Value or Custom. These values are not honored UNLESS this new CFG variable is set.

	CIVIL_SURVEY_USERTIW_FOLDER
	Defines an alternate directory where user .TIW files can be located.

	CIVIL_SURVEY_STYLEFILE
	Defines the Style file that is linked in the survey feature definitions. Available options are an XIN from InRoads, an XML from a GEOPAK SMD, or a PSS from MX.

	CIVIL_SURVEY_SURVEYOPTIONS_NAME
	As the XIN can contain multiple instances of survey options, this allows the definition of particular survey options to apply when reading the XIN file. If this variable is not defined, then the LAST occurrence of the Survey Options is used. (InRoads only).

	CIVIL_SURVEY_GEOID_BINFILE_FOLDER
	Defines an alternate directory where the GEOID BIN files may be located. If not set, the standard GEOID BIN location is used.

	CIVIL_CIVILCELLDGNLIBLIST

	Defines both the directory and specific file name of the DGN Library.
Example: CIVIL_CIVILCELLDGNLIBLIST = c:\workspace\dgnlibs\civilcells.dgnlib
Example: CIVIL_CIVILCELLDGNLIBLIST = c:\workspace\dgnlibs\*.dgnlib
 If this variable is NOT set or the dgnlib file is not found, then the process looks inside each dgnlib specified by the MS_DGNLIBLIST variable and lists any that contain civil cells.
 If this variable IS set and the file is found, then this file is used to list the civil cells. In other words, if this file contains other civil items (such as feature definitions or project settings or filters), they are ignored.

	CIVIL_CONTENTMANAGEMENTDGNLIBLIST

	This variable defines both the directory and specific file name of the feature definitions DGN Library. 

	CIVIL_DESIGNSTANDARDSDGNLIBLIST

	This variable defines both the directory and specific file name of the design standards DGN Library. 

	CIVIL_PROJECTSETTINGSDGNLIBLIST

	This variable defines both the directory and specific file name of the project settings DGN Library. See CIVIL_CIVILCELLDGNLIBLIST for more details.


	CIVIL_CIVILTMDGNLIBLIST

	This variable defines both the directory and specific file name of the terrain model filters DGN Library.



[bookmark: _Toc308648703][bookmark: _Toc352232015][bookmark: _Toc257190025][bookmark: _Toc316480913][bookmark: _Toc316905060]Exercise:  Check Workstation / Laptop Settings
Exercise Objective:  	
Briefly make sure that our computer is setup and ready to go.
Procedure:
1. Use the provided login and password to access your laptop.
Double-click on the appropriate Civil product on your desktop.
 In the File Manager dialog, set the following:
Users > Examples
Project > Bentley-Civil-Imperial
Interface > Bentley-Civil
Open …\data\Seed3D.dgn 

[bookmark: _Toc352232016]Exercise:  Review Configuration Variables
Exercise Objective:  
Briefly review the configuration variables that are being used in our workspace configuration.
Procedure:
1. [bookmark: _Toc316905061]Select Workspace > Configuration from the main menu bar.
2. Review all variables that begin with “CIVIL_”. These are the civil configuration variables that are being used in our workshop today.

[bookmark: _Toc352232017]Chapter Summary
In this chapter, we have made sure that our computers are prepared and briefly reviewed the new civil configuration variables that are available in Bentley Civil V8i SELECTseries3.
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[bookmark: _Toc352232018]Chapter 3:	Seed Files 
[bookmark: _Toc352232019]Overview
Seed files have always been an important part of a MicroStation configuration. The beauty of the seed file is that it can be used to standardize drawings as every new file that you create will have the same attributes (e.g. global origin, color table, cell library attachments, working units, views, etc.) as those that are in the seed file. In Bentley Civil V8i SELECTseries 3, there are certain civil settings and attributes that you will want to consider setting in your design file.
[bookmark: _Toc352232020]Project Description
In this exercise, we’ll review the specific settings that can be very useful on civil projects, as well as the ability to set or standardize these settings within a seed file in order to propagate these standards to new drawings.
[bookmark: _Toc352232021]Geographic Coordinate Systems
MicroStation V8i introduced the ability to assign Geographic Coordinate Systems (GCS) to design file models. This functionality allows the user to specify the position of the design contents on the earth´s surface. Once that position is established, the design can then be easily coordinated with other data for which the geographic location is also known. With civil operations, this can be very useful since civil applications can make use of this GCS when importing data in order to ascertain the location of the imported data and perform a re-projection if required.
[bookmark: _Toc352232022]Exercise: Assign Geographic Coordinate System
In this first section, we’ll review what a Geographic Coordinate System is and then assign one to our seed file model.
Exercise Objective:
Familiarize ourselves with Geographic Coordinate Systems and the ability to assign them to a design file model.  
Procedure:
1. Remain in …\data \Seed3D.dgn.


1. Select Tools > Geographic > Select Geographic Coordinate System.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML1f7d6453.PNG]
On the Geographic Coordinate System dialog, select the icon “From Library”.
Expand the tree under Library as follows:
Library > Projected (northing, easting, …) > North America > United  States of America
Expand the tree under United States of America.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML1f81d0ea.PNG]


Finally, expand the tree under Tennessee and select the GCS as shown.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML1f849716.PNG]
Click OK to accept. The GCS has now been assigned to the design file model.
Close the Geographic Coordinate System dialog.
[bookmark: _Toc352232023]Annotation Scale
Annotation Scale allows a user to set the default scale factor within a particular design file model. This scale is then applied to any text, line styles and cells (if the cells are enabled to recognize the annotation scale) that are drawn in the model. 
Next, we’ll review Annotation Scales and assign a default value to our seed file model.
[bookmark: _Toc352232024]Exercise: Assign Annotation Scale
Exercise Objective:
Familiarize ourselves with Annotation Scales and the ability to assign them to a design file model.  
Procedure:
1. Remain in the file …\data \Seed3D.dgn.
Click File > Models to open the Models dialog.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML1fc49015.PNG]

On the dialog, click the Edit Model Properties icon to open the Model Properties dialog.
Set the Annotation Scale to 1”=50’.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLd81b31f.PNG]

Click OK to close the Model Properties dialog.
Close the Models dialog.

[bookmark: _Toc352232025]Civil Formatting Options
Next, we’ll review the options we have to control civil formatting using the Settings > Design File dialog and how those options can be set in the seed file.
[bookmark: _Toc352232026]Settings > Design Files > Civil Formatting
Most MicroStation users are very familiar with the Settings > Design File dialog, which allows you to control the settings of such things as Active Scale, Angle Readout and Working Units, to name just a few. In Bentley Civil V8i SELECTseries 3, there is now an option for civil settings that allows the same degree of control over civil annotation within the design file. 
Below is a brief description of each option and its functionality.
Export to Native
[image: ]
“Export to Native” is a functionality within Bentley Civil V8i SELECTseries 3 that allows the user to keep a version of the native geometry database (.GPK, .ALG, .FIL) in synch with civil geometry stored within the design file. For example, when enabled the user can store an alignment in the design file and that alignment will be automatically stored in the native geometry database as well. Delete that alignment from the design file, and that alignment will be deleted from the native geometry database. This “Export to Native” functionality is feature based in that the option to “Export to native” must be set to “true” or “false” for each particular feature.
 This option in the Design File Settings dialog controls whether Civil Geometry is exported to the native database automatically or not. When set to “Use Feature Setting”, then any civil geometry elements will be exported to the native database when stored with a feature that has the Export to Native option set to “true”. When set to Manual, Civil Geometry elements can only be exported to the native database via a manual export, regardless of whether the feature being used allows for it or not.
Coordinate Settings
[image: ]
This option allows the user to control the display and precision of their coordinates within any of the civil dialogs. In addition, this setting also controls how any inputted coordinates will be interpreted. For example, if set to “X, Y” then all coordinates will be interpreted and displayed as being in the “X, Y” format. If set to “Nothing, Easting” then the same would apply.
Ratio Settings (Distance: OFFSET)
[image: ]
This option allows the user to control the display and precision of their ratios within any of the civil dialogs. In addition, this setting also controls how any inputted ratios will be interpreted. For example, if set to “1:D” then all ratios will be interpreted and displayed in this format (e.g. 1:100, 1:50, etc.). If set to “D:1” then the ratios would be similarly displayed and interpreted (e.g. 5:1, 10:1, etc.).

Station Settings
[image: ]
Here, the user can control the format, delimiter and precision of the station values to be used and displayed in the civil dialogs. In addition, there are two options to control how equations are represented within the station values.
By Name – This is the standards InRoads presentation (A100+00, B105+00, etc.).
By Index – This is the standard GEOPAK presentation (100+00 R 1, 105+00 R 2, etc.).
Radius Settings
[image: ]
Degrees of Curve Method – Two options are available, Arc and Chord.
Degree of Curve Length – This sets the standard definition of a 1^ curve.
Radius Toggle Char – This allows the user to specify which character will be used within the civil dialogs to ‘toggle’ between a radius definition and a degree of curve definition.
Profile Settings
[image: ]
This option allows the user to control the precision and display/input formats of slopes and ratios within a profile context. In addition, the default Vertical Curve Parameter Format (Rvalue or Kvalue) can be set as well.


[bookmark: _Toc352232027]Exercise: Review and Modify Civil Formatting Options
Exercise Objective:
Familiarize ourselves with the new Civil Formatting option available under the Settings > Design file dialog and the ability to assign these settings in a seed design file.  
Procedure:
1. Remain in the file …\data \Seed3D.dgn.
Open the Settings > Design File dialog and click on the Civil Formatting option.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML1fe5de35.PNG]

Modify the following options in our seed file model:
Coordinate Settings > Precision: 0.12
Ratio Settings > Precision: 0.12
Station Settings > Precision: 0.12
Profile Settings 
Elevation Precision: 0.12
Slope Format: Decimal
Slope  Precision: 0.12
Ratio Precision: 0.12
Vertical Curve Parameter Format: KValue
Click OK to close the Design File Settings dialog.

[bookmark: _Toc352232028]Workspace > Preferences > Civil Formatting 
Finally, we’ll review the options we have to control civil formatting under the Workspace > Preferences dialog and how those options can be set in the seed file.
Whereas the MicroStation Design File Settings allow for the configuring of standards within a design file that can be propagated throughout an organization, the Workspace Preferences are more geared toward the individual user. In other words, they allow each user to control settings such as the look and feel of MicroStation – things that a user may prefer but don’t have an overall effect on the project data.
In the same vein, civil formatting options have been added to Workspace Preferences in Bentley Civil V8i SELECTseries 3. These are option that have no overall effect on the generated design data, but are geared more toward the look and feel of civil on a user level.
Although geared more toward individual users, an organization may want to set some of these as default values in their seed files.
Toggle Commands
[image: ]
These settings allow the user to control the default status of the Features Definition Toggle Bar icons. If set to True, then an icon will be enabled by default, whereas if False, the icon will be disabled by default.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLd8ccd53.PNG]
Manipulator Settings
[image: ]
These settings allow the user to control the settings and symbology of the civil geometry manipulators and any associated text.
[image: ]
Superelevation Settings
[image: ]
Allows for the control of the superelevation graphical components.

Survey Locator
[image: ]
This setting is used by the Survey tools to control the display and symbology of the locator.

Maximum Error Ellipse
[image: ]
Survey only – This setting allows the user to specify a major error ellipse value with regard to the standard deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this limit would result in a graphical flag based on this symbology.
Medium Error Ellipse
[image: ]
Survey only – This setting allows the user to specify a medium error ellipse value with regard to the standard deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this limit would result in a graphical flag based on this symbology.
Minimum Error Ellipse
[image: ]
Survey only – This setting allows the user to specify a minimum error ellipse value with regard to the standard deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this limit would result in a graphical flag based on this symbology.
[bookmark: _Toc352232029]Exercise: Review and Modify the Preferences > Civil Formatting Options
Exercise Objective:  
Familiarize ourselves with the new Civil Formatting options available under the Workspace > Preferences dialog and the ability to assign these settings in a seed design file.  
Procedure:
1. Remain in the file … \data \Seed3D.dgn.
Open the Workspace > Preferences dialog.
Select View Options – Civil.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML206b76ed.PNG]


Make the following changes:
Manipulator Settings: 
			Manipulator Size: 25
			Normal Color: Your choice of any color
Click OK to close the Preferences dialog.
File > Save Settings.
[bookmark: _Toc352232030]Chapter Summary
In this chapter, we have reviewed the various settings and how to set up seed files.
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[bookmark: _Toc352232031]Chapter 4:	Basics of DGN Libraries
[bookmark: _Toc352232032]Overview
In Bentley Civil V8i SELECTseries3, one of the things you will find true is that many of the standards and preferences are located within DGN Libraries, commonly referred to as DGNLibs. DGN Libraries are design files typically used as a shared resource in order to store such things as cells, levels, text styles, etc.  They allow administrators to store standards and features in one place and then distribute them to many users across an organization. MicroStation has of course used this functionality for quite awhile and now the civil products will take advantage of this same functionality. 
In this exercise, we’ll review the use of DGN Libraries to store both a MicroStation standard (in this case a text style) as well as a civil standard (in this case an element template). 
The use of MicroStation element templates to control civil artifacts is a new concept in Bentley Civil V8i SELECTseries3, one which we’ll introduce here within the context of their use in DGN Libraries. We’ll then use the standards to draw and label a terrain model.
[bookmark: _Toc352232033]Text Styles
In this first section, we will modify a text style within a MicroStation DGN Library to be used for labeling contours.
[bookmark: _Toc352232034]Exercise: Modify Text Style
Exercise Objective:  
Familiarize ourselves with DGN Libraries and their use.  
Unless otherwise specified, for GEOPAK users, all DGNLibs used in the following exercises are located in the following directory structure:

C:\ProgramData\Bentley\PowerGEOPAK V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\

Unless otherwise specified, for InRoads users, all DGNLibs used in the following exercises are located in the following directory structure:

C:\ProgramData\Bentley\PowerInRoads V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\

Procedure:
1.  Open the file Text_Styles_Dimensions_Imperials.dgnlib
1. Open the Text Style dialog using Element > Text Styles.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML898a08f.PNG]
Select the text style “Civil-Existing Contours”.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML89db7f6.PNG]
Select the General tab, setting the following:
Color = 2
Justification = Center Center
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML8ac30bd.PNG]
Exit the dialog and save settings.

[bookmark: _Toc352232035]Element Templates
Next, we will review element templates in MicroStation to control the display of our terrain model. These reside in a separate DGN Library from our previous text styles.
We could create both text styles and element templates in the same DGNLib. How the DGNLibs are setup and what specific standards are contained in each one is up to the individual manager or organization that is creating them.
[bookmark: _Toc352232036]Exercise: Modify Element Templates 
Exercise Objective:  
Continue to familiarize ourselves with DGN Libraries while at the same time introducing Element Templates.
Procedure:
1. Open the file Element_Templates_Imperial.dgnlib.
Open the Element Templates dialog using Element > Element Templates.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML8b4e5ba.PNG]
1. Expand the tree for Element_Templates_Imperial.dgnlib.
Expand the Terrain category and select the Element Template Existing_Contours.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML8b64c49.PNG]
Under Calculated Features Settings, expand the Contours tree and set the following:

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML8b99c4c.PNG]

Major Interval = 5
Minor Interval = 1
Major Contour > Text Interval = 150
The text style is set to use Civil-Existing Contours, which we modified in the previous exercise.
Close the dialog.

[bookmark: _Toc352232037]Using Standards
In our final exercise, we’ll use the standards that we previously modified in our DGNLibs in order to control the display and labeling of a terrain model.
[bookmark: _Toc352232038]Exercise: Display and Label Terrain Model 
Exercise Objective:  
Use standards from DGNLibs to display and label a terrain model.
Terrain Model Tools Used:  
	Terrain Modeling Panel
	Icon
	Tool

	[image: ]
	[image: ]
	Create From File



Procedure:
1. Open the file … \Data\ExistingGround.dgn.
Select the Create From File command. 
Select the Ground.TIN file or the Ground.DTM file, whichever you prefer.
Set the dialog settings as follows:
Source File Units = US Survey Feet
Feature Definition = Terrain Display > Existing_Triangles
Import Options = Import Terrain Only
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML8cde8b7.PNG]

Click Import.
Close the Import Terrain Model dialog and fit the view. Review the terrain model.
Select the Terrain Model.
From the Active Element Template pull down, expand the Terrain tree and select the Existing_Contours Element Template.
[image: ]
Review the terrain model and note the changes to the display.
Access the Settings > Drawing Scale dialog.
Change the scale to 1”=20’ to change the size of the contour labels.

[bookmark: _Toc352232039]Chapter Summary
In this chapter, we have introduced the ability to use Element Templates to control the display and labeling of Terrain Models. We have also shown how these reside in a DGN Library along with other standards such as text styles, so that these standards can be stored and maintained in a central location and then distributed across an organization.

[bookmark: _Toc352232040]Chapter 5:	Project Explorer 
[bookmark: _Toc352232041]Overview
Project Explorer is a standard dialog with tree views for Links and Files for managing data in the current MicroStation project. The tabs for Links and Files will not be covered in this workshop and more information is available in MicroStation Help. This capability has been expanded to manage civil data by adding tabs for Survey, Civil Model and Civil Standards. 
You will take a tour of the sections, settings and capabilities of the Civil Standards tab along with a brief review of the Civil Model tab. The Survey tab is most applicable when survey data is present and that is outside the scope of this workshop.
The Project Explorer is accessible from MicroStation > File > Project Explorer or from the Primary Tool Bar. There are settings to control which tabs are displayed and you will be using the dialog. If the Project Explorer is not visible on your Primary Toolbar, then right-click on the toolbar and toggle on Project Explorer. This command can be docked on either the left of right side of the screen in a pinned or unpinned state. 
[bookmark: _Toc352232042]Exercise: Tour of Project Explorer
[bookmark: _Toc352232043]Exercise Objective:  
Familiarization with Project Explorer’s Civil Model and Civil Standards tabs.
Procedure:
Settings
1. Open the file Feature_Definitions_Imperial.dgnlib.  
Open MicroStation > File > Project Explorer and leave the dialog on the desktop undocked. Review the various tabs in the dialog.
Open MicroStation > Settings > Project Explorer to view the options. At the top you see the various tabs set to true. 
Change the Survey tab to False since we are not going to use it and then select OK. On the dismissal of the Settings the Project Explorer changes and the Survey tab is no longer visible. 

In dialogs which have True/False or On/Off instead of clicking on the drop down item and selecting the state you can change binary state items by double clicking on the name. Try it by double clicking on Survey to change states.


Civil Model
Select the Civil Model tab and expand the tree. This tab contains a breakdown of the civil data objects that exist in this design file and any referenced data. 
The first step in the hierarchy is design file. Any design files attached to this design file will also appear in the tree view. When present a plus (+) to the left of an item indicates additional information in the tree.
Under each design file is a listing of data types:
Linear Elements – featurized lines, curves, spirals, etc. 
Point Elements – featurized points
3D Linear Elements – featurized elements in 3D
Terrain Models – lists the terrain models
Corridors – lists the corridors and all dependent data
Superelevation – lists superelevation data
Civil Cells – lists civil cells present in the design file
Civil Objects – lists the civil objects present in the design file
Referenced Models – lists all referenced dgn models
Each type has a further break down of information which we will not go into today. Suffice it to say the data listing is extensive. Each item has a selection of actions available by right-clicking ranging from commands to properties that are appropriate actions for that data type.

Civil Standards
Select the Civil Standards tab, then expand and review the trees. The Civil Standards tab provides access to features and settings stored in DGNLIB or design files.
The top level has the current design file and libraries. Libraries are the collection of DGNLIB files that are associated with the MicroStation project. As settings and standards are used they are copied into the design file.
Under the Design File and Libraries are the following sections:
Civil Cells – Preconfigured geometric configurations
Design Standards – Includes curve tables for horizontal and vertical curves by speed
Feature Definitions – Holds the collection of features
Filters – Contains filters and filter groups for importing terrain models from graphics
Project Settings – Contains Corridor and Survey settings
Feature Definitions population and uses are covered in Chapters 5 and 6 of this workshop.
Design Standards are covered in Chapter 8 of this workshop.
[bookmark: _Toc352232044]Chapter Summary
The Civil Standards tab provides access to setting, features and design standards. The Civil Model tab has the civil data in a hierarchical tree structure. Pertinent actions can be invoked with the right-click menus on each entry.



[bookmark: _Toc352232045]Chapter 6:	Linking Legacy Settings 
[bookmark: _Toc352232046]Overview
Bentley Civil products (GEOPAK, InRoads and MX) each have files that define names of styles and how they are drawn in graphics. These files represent an investment in time and effort so the transfer of these styles to features in the DGNLIB is important. Technically, we are not importing the styles. The files are linked to features of the same name in the DGNLIB. These features are looking up symbology out of a .DDB, .PSS or .XIN file and placing graphics with those values.  
[bookmark: _Toc352232047]Exercise: Reviewing Linked Active Styles
Exercise Objective:
Review linked styles.  
Procedure
1. Remain in the file Feature_Definitions_Imperial.dgnlib.  
1. Open the Project Explorer and the Civil Standards tab.

Since we are in the Bentley-Civil-Imperial workspace, the feature definitions have already been linked. The following step is for review purposes only.

Right-click on Feature Definitions and review the options.
[image: ]    [image: ][image: ]
InRoads options                                       GEOPAK options                                      MX options
Upon selection the styles are read into the DGNLIB file as linear, point and surface features.


[bookmark: _Toc352232048]What happens - Inroads?
The XIN is read.
All feature names must be unique. 
Features have three types: Linear, Point and Surface.
Survey features are linked separately. 
All styles which have the Geometry Line, Curve or Spiral defined on are added to the linear section. 
All styles which have the Surface setting for 3-D/Plan Display turned on are added to the linear section.
All styles where the Geometry Points is defined are added to the Point section. 
All styles that have the Surface Setting for Components turned are added to the Surface section.
Names are assigned in the order Surface > Linear > Point. 
Example
Pavement style fits all sections. Pavement is the name added to Surfaces, Pavement-Lin is added to Linear and Pavement-Pnt added to Points. If Pavement only had geometry defined in the XIN file then Pavement is the name in Linear and Pavement-Pnt is the name in Points.

InRoads Mapping for Linked Styles	
	Feature
	InRoads Style

	Linear
	Linked Style Symbology

	Plan – Line
	Geometry Line Plan Line

	Plan – Curve
	Geometry Curve Plan Line

	Plan – Spiral
	Geometry Spiral Plan Line

	Profile – Line
	Geometry Line Profile Line

	Profile – Parabola
	Geometry Curve Profile Line

	Cross Section Point
	Surface Cross Section Point

	3D – Line
	Surface Plan Line

	Survey – Point
	Survey Plan Point

	Survey – Line
	Survey Plan Line

	Intersected Profile Point
	Geometry Point Plan Point

	Projected Profile Line
	Surface Plan Line

	Point
	

	3D – Plan
	Geometry Point Plan Point

	Surface
	

	Profile
	

	Cross Section
	Surface Cross Section Line

	3D
	Element Template





How the linking works
A native style is linked to a particular attribute such as Plan or 3D.
[image: ]

[bookmark: _Toc352232049]What happens - GEOPAK?
The DDB is read.
All feature names must be unique. 
Features have three types: Linear, Point and Surface.
Survey features are linked separately to the Survey Manager Database (SMD) in XML format.
Features may be linked to DDB Item Names or Item Descriptions. The Item Descriptions link is useful if the Item Name is simply a pay item number with no description.
[image: ]
Native Style in Project Manager Used in Plan and Several Profile Options
[image: ]
Native Style Relating to DD Item Name and Associated Settings
[bookmark: _Toc352232050]What happens – MX?
The PSS is read into a flat structure the same as we get in Style Set Editor.
Since a MX PSS only holds a single style representation and does not distinguish between plan / profile / section / 3d, by default the same style definition is applied to each persona. The persona styles can be modified later to take advantage of different display representations.
The MX string feature types are matched to the appropriate feature definitions from the following table: 
	Feature
	Supported MX String types
	Default Style Mapping

	Surface
	Cross Section strings
Long Section Strings
Triangulation Strings
	MicroStation Element Template
On import a new Element Template  is created 
· Category ( PSS name) >  Feature Name
Using feature style to define Level, colour, linestyle, weight, material (if defined).

	Linear
	Feature Strings
Interface Strings
Master Strings
Geometry Strings
	PSS feature 

	Point
	Survey Station
Point
Cadastre 
	PSS feature



Feature names must be unique and names are assigned in the order Surface > Linear > Point. 
[image: ]
The PSS structure is ‘flat’ and so all features are initially loaded to match this historic flat feature definition structure. However this is an opportunity to categorize features into groups, possibly of similar features or into a method of your own choosing, too enhance the normal MX feature structure. 
Example the MXRoad.pss could be imported and grouped with sub categories for all the different string features that fit the category like Carriageways / Shoulders / Alignments / Earthworks etc. 
In this case, create a category called MXRoad and move all features under it.
[bookmark: _Toc352232051]Linking Survey Styles
Note the linking in the previous section did not include Survey.  They are linked separately. 
[bookmark: _Toc352232052]Link Survey Styles to DGNLib
Objective:
Review the process to link Survey styles to a DGNLIB.
Procedure:
The steps vary because the linked file is identified from disk as opposed to an active style file.
1. Open the file  Survey_Feature_Definitions_Imperial.dglib.
1. Expand the tree in Project Explorer.
1. Right-click on Feature Definitions and select Link Survey Feature Definitions from the pop-up menu.
[image: ]

This dialog allows you to select the appropriate style file for your product. 
[image: ]
If the feature name already exists in the DGNLib, then the survey information is added to the existing feature. Else, if the survey features do not exist, they are created.
1. Close the Select Linked  Feature Definition Style File dialog.
[bookmark: _Toc352232053]Chapter Summary
These steps demonstrate how style files are linked to features in a DGNLIB. You did not transfer the symbology into the DGNLIB. You have created entries that are linked back to the DDB/PSS/XIN file where the native product symbology is defined or to element templates in a DGNLIB.


[bookmark: _Toc352232054]Chapter 7:	Working With Features 
[bookmark: _Toc352232055]Overview
The Project Explorer has facilities to create, maintain and delete the features you linked in the previous chapter. These capabilities will be reviewed in this chapter. You will explore these functions that can be used by System Administrators or Project Managers setting up the Civil Standards for your organization. These steps are similar whether you are in GEOPAK, InRoads or MX.
Configuration Variables
A configuration variable can be used to point to the location of your feature definitions DGN Libraries.
Example:
CIVIL_CONTENTMANAGEMENTDGNLIBLIST > $(_USTN_PROJECTDATA)/dgnlib/ Examples/*.dgnlib
CIVIL_CONTENTMANAGEMENTDGNLIBLIST > $(_USTN_PROJECTDATA)/dgnlib/Examples/Features/Features. dgnlib
If this variable is NOT set or the specified DGNLib file is not found, then the process looks inside each DGNLib specified by the MS_DGLIBLIST variable and lists any that contain civil features.
If this variable IS set and the DGNLIb(s) is found, then only this DGNLIB(s) is used to list the features. In other words, if this file contains other civil items (such as civil cells or project settings or filters), they are ignored.
[bookmark: _Toc352232056]Managing Features
You will review component, linear, point and surface features in this chapter.
[bookmark: _Toc352232057]Working with Linear Features
Exercise Objective:  
Review properties of Geom_Centerline. 
Command used: Project Explorer
Procedure:
1. Open the file Feature_Definitions_Imperial.dgnlib.  
1. Access the Civil Standards tab under Project Explorer.
1. Expand the Feature Definitions tree to locate the following feature:
Linear > Geometry > Geom_Centerline
1. Select the Geom_Centerline feature and right-click to review its properties.
Default naming for the feature can be defined. Here the example is set to GeomCL which would be the name of the first element with this feature in the design. Subsequent elements would be named GeomCL1, GeomCL2, etc..
[image: ]
Next take a look at the Plan Settings.
[image: ] 

Besides the Native Style which is set automatically, Auto Export = True will automatically export any geometry that uses this feature to the appropriate ALG/GPK/FIL file.  Auto Annotate = True will automatically annotate (station) any geometry element that is placed using this feature.
In order for Auto Annotate to work, Auto Export MUST be set to True.
Next the Profile has several attributes but the main one we need to be concerned about is Auto Export. If the ALG/GPK/FIL files are to be kept current, then this attribute is set to True.
[image: ] 
Review the following properties as well.
The Intersected Profile determines the point symbology when a command has to display the intersection point of objects with the feature on a profile.
[image: ]
The Projected Profile is similar except that it determines the line symbology when an object with this feature is projected onto another profile.
[image: ]
Cross Section is how the element with this feature will be represented in the Dynamic Section and cross section plans. Most linear elements will be placed as points.
[image: ]
3D is how the element with this feature will be drawn in a model.
[image: ]

Finally, for a linear feature the Linear Default Settings extend the functionality of a feature.
[image: ]

Automatically Create 3D Elements
If true, and if also the 3D option is toggled ON in the toggle bar, then a design profile is automatically created whenever a horizontal element is created.  The profile that is created will be one of the following:
If the element does not connect to adjacent elements which contain a design profile, then a best fit profile rule is created.
If the element is connected to adjacent elements with a design profile then a quick profile rule is created.
If the element if connected to adjacent elements, yet the adjacent elements do not contain a design profile, the rule is still created but the 3D element will not appear until the adjacent elements receive a design profile.
Example: Line By points which stands alone, with Create 3D toggled on.  A best fit profile rule is created.  
Example: Use Arc Between Elements to create a curb return.  A quick profile for the curb return is created based on the design profiles of the adjacent edges of pavement. If, per chance, the adjacent edges do not yet have a design profile then the rule is still created but no profile nor 3D will be evident until such time as both adjacent elements receive a design profile definition.

Corridor Template
This property allows you to define a template which will automatically be attached to the horizontal geometry element as soon as it is placed.  You must have the template toggle ON in the Features Toggle bar. Similar to above, no 3D model will appear until the element has a design profile created, so using the Template toggle will often go hand in hand with Create 3D toggle.  But, you can toggle ON template even without a design profile and the template drop will be created but no 3D model until such time as a design profile is named.

Terrain Model Feature Type
When the 3D element is created using this feature definition, define what sort of behavior it will have when it is used in a terrain model (break line, boundary, etc.)
Create Template Geometry
If you create a template drop as part of a corridor or a linear template, and if the template contains points matching this feature definition, then 2D and 3D geometry will be created. However, these elements are not ruled to the centerline, they are artifacts of the corridor.
However, if you use the Create Geometry by Template command, and if the template contains points matching this feature definition, then 2D horizontal geometry will be created in the plan view and the geometry will be ruled to the centerline using the horizontal offset rule.

[bookmark: _Toc352232058]Working with Point Features
Exercise Objective:  
Review properties of Geom_PropertyCorner. 
Command used: Project Explorer
Procedure:
1. Remain in the file Feature_Definitions_Imperial.dgnlib.  
2. 	Access the Civil Standards tab under Project Explorer.
3.	Expand the Feature Definitions tree to locate the following feature:
Points > Geom_PropertyCorner
This section contains features linked to styles that had geometry points defined.
1. Select the Geom_PropertyCorner feature and right-click to review its properties.
[bookmark: _Toc352232059]Working with Surface Features
Exercise Objective:  
Surface features are used to define existing terrain model attributes as well as proposed surface meshes and component displays.  In this exercise we’ll review both.
Command used: Project Explorer
Procedure:
1. Remain in the file Feature_Definitions_Imperial.dgnlib.  
4. First, let’s review surface features that control existing terrain models. Expand the Feature Definitions tree to locate the following feature:
Terrain Display > Existing Contours
5. Review the Profile properties. This defines the symbology of the existing profile.

[image: ]

6. Review the Volume properties. This is important when running cross section average end area volumes, as it tells the software how this particular terrain is to be analyzed in the computations. In this case, it is to be treated as existing.

[image: ]

7. Finally, let’s look at surface features that are used to control surface meshes and component displays. Expand the Feature Definitions tree to locate the following feature:
Components > Roadway > Road_Pave_Aggregate
8. Review the 3D properties. This denotes which Element Template will be used to symbolize the component/mesh in 3D.

[image: ]

Review this Element Template by opening the Element Templates dialog using Element > Element Templates.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLd31c1cd.PNG]
9. Notice the level specified is Road_Pave_Aggregate. Now open Level Manager and review the level and its pre-assigned material, Gravel_1.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLd334915.PNG]

This is what allows materials to be drawn automatically, without any additional visualization work by the user.

10. Finally, review the volume properties. Again, this is important when running cross section average end area volumes, as it tells the software how this particular surface/component/mesh is to be analyzed in the computations. In this case, it is to be treated as Subgrade

[image: ]


Chapter Summary
In this chapter you reviewed the attributes of different types of features. The attributes in each feature define how the elements are shown in various stages of the drawing/models.


[bookmark: _Toc352232060]Chapter 8:	Standards
[bookmark: _Toc352232061]Overview
Two major applications within Bentley Civil SELECTseries3 require enterprise-wide set-up.  These applications are:
Design standards – used by planning, design, and geometric review functions
Superelevation preferences – used by design functions
Both applications can be based off AASHTO standards, but that is not required.  Generally, state transportation agencies will use AASHTO as a starting point, compare to their own standards, and adjust accordingly.  
Both applications are optional in usage.  Therefore, they can be deployed at any time, within a total deployment or separately, as individual applications.  However, the superelevation application needs to be implemented at the same time as Corridor Modeling. 
[bookmark: _Toc352232062]Design Standards
Design standards can be used to maintain required curvature and other alignment checks when performing horizontal and vertical geometric layouts. They work at two levels:
Provide values for the element creation tools (for example, minimum radius and transition lengths)
Check the suitability of complex elements (for example, check for kinks in the alignment)
When a design standard is violated, feedback is provided in two ways:
A graphic icon is generated on the element that has the problem. Hover over the icon to reveal a tool tip report of the error in the Civil Message Center
Design standards are normally utilized by Design personnel, and perhaps to a lesser extent, Planning and Preliminary Design staff.  
In order to utilize Design standards, it is critical for each organization to review their standards in comparison to the AASHTO standards, and adjust accordingly.  As standards rarely change, posting in a central location or ProjectWise in a read-only mode is recommended.   As a designer uses a particular standard, it is automatically copied into their active design file, where it can be overruled on a file by file basis. 
If your organization is already using SELECTseries 2, you need only add the vertical standards and associate them back to the horizontal standards.  However, if you are not using SELECTseries 2, then you will define the vertical standards first and then the horizontal. 
Depending in the composition of your support staff, you may to enlist the expertise of your Standards engineer or Manager, along with key users within your Design section.  They will be critical to define, review, and test standards prior to implementation. 
Multiple sets of standards can be defined within a DGNLib or one set per DGNLib. In order to create or modify the standards, you must be in the DGNLib where the data resides.  The modification is done from within Project Explorer in the Civil Standards tab.   
The data is based on design speed and a lot of the associated data is redundant.  Therefore, you will want to think about the hierarchy that you want, so you utilize copy and paste functions.  
Configuration Variables
A configuration variable can be used to point to the location of your Design Standards DGN Libraries.
Example:
CIVIL_DESIGNSTANDARDSDGNLIBLIST  >  $(_USTN_PROJECTDATA)/dgnlib/ Examples/Design Standards/*.dgnlib
CIVIL_DESIGNSTANDARDSDGNLIBLIST  >  $(_USTN_PROJECTDATA)/dgnlib/Examples/DesignStandards. dgnlib
If this variable is NOT set or the specified DGNLib file is not found, then the process looks inside each DGNLib specified by the MS_DGLIBLIST variable and lists any that contain design standards.
If this variable IS set and the DGNLIb(s) is found, then only this DGNLIB(s) is used to list the design standards. In other words, if this file contains other civil items (such as civil cells or project settings or filters or features), they are ignored.

[bookmark: _Toc352232063]Review Design Standards 
Objective:
In this exercise we are going to quickly review the common hierarchy of AASHTO standards.
Tools Used:
Project Manager
Procedure:
1. Open c:\ProgramData\Bentley\Civil\Standards\8.1.9\en\Design Standards\AASHTO 2004 Design Standards.dgnlib.  
Open Project Explorer.  
Select the Civil Standards tab.
Expand the tree and select Design Standards.
Expand the Design Standards > Horizontal  tree as shown.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdafd955.PNG]
Select 2 Lane 6% Super 65MPH, right-click and select Properties.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb13f67.PNG]

In the Design Values section, click in the Table field to open the Table Editor.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb20d41.PNG]

Close the Table Editor.
Expand the Vertical tree as shown.  

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb2e47c.PNG]

Select Stopping Sight Distance, right-click and select Properties.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb2e47c.PNG]

Click in the Table field to open the table to review the table entries.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb491fa.PNG]
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLdb5d1c7.PNG]
Close the Vertical Table Editor. 

[bookmark: _Toc352232064]Superelevation Preferences
Superelevation is tilting or banking of a roadway in areas where the roadway is curved.  Extensive calculations and standards are utilized by governmental agencies internationally.  
[image: C:\Users\LOU~1.BAR\AppData\Local\Temp\SNAGHTML24d35bd6.PNG]
Superelevation calculations are used within Corridor Modeling which is normally utilized by Design personnel, and perhaps to a lesser extent, Planning and Preliminary Design staff.  However, the layout and calculations are done independent of Corridor Modeling. 
In order to utilize superelevation in accordance with your organization, it is critical for each organization to review their standards in comparison to the AASHTO standards, and adjust accordingly.  As standards rarely change, posting in a central location or ProjectWise in a read-only mode is recommended.   When a project requires deviation from the standards, the designer can make the necessary adjustments within the design file without impacting the superelevation standards. 
In terms of deployment, superelevation must be deployed coincident with the Corridor Modeling application.  While the designers can use the default superelevation preferences provided with the software, the results may not match your organization’s standards. 
Two sets of preferences are supported:  U.S. method (SEP) and International method (SRL).   However, a client may choose to create both preferences, and the user may decide which one to utilize on a project-by-project basis.  
Current MX clients may use the SRL files created in previous versions, and GEOPAK clients may use their legacy SEP files. InRoads SUP files are not supported in SELECTseries 3.  
The SRL and SEP files are not product specific, i.e., MX, GEOPAK and InRoads can run either SRL or SEP file preferences.  They are not stored in DGNLibs.
The table below delineates some of the differences between the SRL and SEP options.  Our goal is not to make everyone super experts, but provide some tools to get the appropriate discussions started. 
	Feature
	SEP Preferences
	SRL Preferences

	General Methodology
	Tables
	Equations

	Master File
	SEP   (ASCII)
	SRL  (ASCII)

	Auxiliary Files
	2 CSV files to define e method and RG / length if not using equation
	8 ASCII files , but 2-3 for  a typical project. 

	Multiple lanes with different default cross slope
	Supported
	Not supported

	Adjustment Factors
	Supported
	Not supported

	Half Lanes
	Supported
	Not supported

	Axes of Rotation / Pivot Methods
	Two methods supported -  Centerline, Inside Edge 
	Six methods supported

	Reverse Curve Treatment 
	Multiple options
	Only Linear Interpolation

	Compound Curve Treatment
	Multiple options
	Only Linear Interpolation

	Early Start Indicator 
	Not supported
	Supported

	Manipulate by Constraints
	Not supported
	Supported

	Inside edge (pivot changing sides of road)
	Not supported
	Supported



Depending in the composition of your support staff, you may to enlist the expertise of your Standards engineer or Manager, along with key users within your Design section.  They will be critical to define, review, and test standards prior to implementation. 
First, determine whether your organization is currently using either SEP or SRL files.  If so, they can be used with no changes needed.
If you are not using either method, using the chart above, begin by determining whether the SEP or SRL method (or both) fit your organization’s standards.  You may use both.
Next, review your standards to the provided default standards.  You may also want to obtain files from other governmental transportation agencies and modify.  
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[bookmark: _Toc352232065]Chapter 9:	Graphical Filter Library
[bookmark: _Toc352232066]Overview
Data is often provided in a variety of formats for consumption into terrain models. These typically include raw graphical elements in both 2D and 3D formats. The Create Terrain by Graphical Filter option requires elements must be 3D and the tool is particularly useful when the source data has consistent (i.e., standardized) element symbology since automation can be achieved. 
[bookmark: _Toc352232067]Graphical Filters 
Rather than defining the element symbology for each terrain feature each time a terrain model is created, the information can be stored in a filter group. Numerous groups can be stored and distributed as DGNLib, so the user merely selects the appropriate group, based on the type of features and associated symbology. If none of the groups are applicable, a new filter group can easily be created.
[image: C:\Users\IAN~1.ROS\AppData\Local\Temp\SNAGHTML113d04da.PNG]
DGNLib Filters
The advantage of the Create Terrain by Graphical Filter tool is that numerous terrain features can be imported simultaneously; the user does not have to select each feature individually, as with the Create Terrain by Elements tool. However, there must be consistency in the source data to utilize this tool.
Configuration Variables
A configuration variable can be used to point to the location of your Graphical Filter DGN Libraries.
Example:
CIVIL_CIVILTMDGNLIBLIST >  $(_USTN_PROJECTDATA)/dgnlib/ Examples/Filters/*.dgnlib
CIVIL_CIVILTMDGNLIBLIST  >  $(_USTN_PROJECTDATA)/dgnlib/Examples/Filters. dgnlib
If this variable is NOT set or the specified DGNLib file is not found, then the process looks inside each DGNLib specified by the MS_DGLIBLIST variable and lists any that contain graphical filters.
If this variable IS set and the DGNLIb(s) is found, then only this DGNLIB(s) is used to list the graphical filters. In other words, if this file contains other civil items (such as civil cells or project settings or design standards or features), they are ignored. 
[bookmark: _Toc352232068]Update Terrain from Source
Terrains that have been created using graphical filters retain the creation rule on the Terrain. This is accessible in Project Explorer under the Civil Model – Terrain Models. Mouse Selection of the Rule allows updating the Terrain Source, this reprocesses the rule adding additional graphical elements.

[image: ]
Update Terrain Source
[bookmark: _Toc352232069]Graphical Filter Tasks
[image: ]
Civil Terrain Tasks

	[image: E:\bcHelp\bcHelp\source\Civil Enhancements Help\Civil_Terrain_Modeling\images\civic-tm-createterrainmodelbygraphicalfilter.jpg]
	Create Terrain Model by Graphical Filter
	The command to create / append terrains using predefined filters or filter groups



[image: E:\bcHelp\bcHelp\source\Civil Enhancements Help\Civil_Terrain_Modeling\images\civdb-tm-createbygraphfilter.jpg]
Create Terrain Model by Graphical Filter

	[image: E:\bcHelp\bcHelp\source\Civil Enhancements Help\Civil_Terrain_Modeling\images\civic-tm-graphicalfiltermanager.jpg]
	Graphical Filter Manager
	Filter Manager provides the management tools necessary for creating / editing Filter Groups and defining individual 



[image: C:\Users\IAN~1.ROS\AppData\Local\Temp\SNAGHTML106cec95.PNG]
Graphical Filter Manager

[image: C:\Users\IAN~1.ROS\AppData\Local\Temp\SNAGHTML1073406f.PNG]
Edit Graphical Filter 
[bookmark: _Toc352232070]Review Graphical Filters
Objective:
In this exercise we are going to review the graphical filters delivered with the Bentley-Civil-Imperial workspace.  
Procedure:
1. Open the file Survey_Feature_Definitions_Imperial.dgnlib.  
1. Open Project Explorer and expand the Filters tree as shown in the following image.


[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe504c17.PNG]

Right-click on the Filter Group Existing Terrain and select Filter Manager. 
Review the filters and groups in the dialog.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe573df4.PNG]

Close the Graphical Filter Manager dialog.
1. Open the file Feature_Definitions_Imperial.dgnlib.  
Open Project Explorer and expand the Filters tree as shown.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe5a3ba4.PNG]

Right-click on the filter Design -  Road Surface Only and select Filter Manager.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe5d2131.PNG]

1. In the Graphical Filter Manager dialog, select the filter Design – Road Surface only, then click the Edit Filter button and review the symbology settings.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe5d7ecb.PNG]

1. Close the Edit Filter dialog.
1. Close the Graphical Filter Manager dialog.



[bookmark: _Toc352232071]Chapter 10:	Project Settings
[bookmark: _Toc352232072]Overview
The Project Settings allow a user to customize preferences to be used in the creation of corridor designs and surveys. These preferences can be applied as the defaults for both corridor design and survey creation, or they can be applied at various time increments throughout a project.  In addition, these Project Settings can be saved in DGN Libraries and then propagate across an organization.
Configuration Variables
A configuration variable can be used to point to the location of your Graphical Filter DGN Libraries.
Example:
CIVIL_PROJECTSETTINGSDGNLIBLIST >  $(_USTN_PROJECTDATA)/dgnlib/ Examples/Project Settings/*.dgnlib
CIVIL_PROJECTSETTINGSDGNLIBLIST  >  $(_USTN_PROJECTDATA)/dgnlib/Examples/ProjectSettings. dgnlib
If this variable is NOT set or the specified DGNLib file is not found, then the process looks inside each DGNLib specified by the MS_DGLIBLIST variable and lists any that contain project settings.
If this variable IS set and the DGNLIb(s) is found, then only this DGNLIB(s) is used to list the project settings.  In other words, if this file contains other civil items (such as civil cells or graphical filters or design standards or features), they are ignored.
[bookmark: _Toc352232073]Corridor  Design Stages
These settings allow an organization to specify different design stages for a corridor, then apply particular preferences for each design stage. For example, in a ‘preliminary’ design stage, we may turn off the critical sections and not include the cardinal points or densify the curves.  This allows the model to build and update much faster, which is fine in a conceptual design stage. Later, we may want to apply a ‘final’ design stage, which enables the cardinal points and densifies the curves.
The Bentley-Civil-Imperial workspace delivers 4 Corridor Design Stages: Preliminary, Design, Final and Final w/Meshes. 
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLe737bfe.PNG]
Each Corridor Design Stage includes the following properties.
Template Management
[image: ]
The Template Drop Interval Multiplier is applied to the original template drop. For example, if a template was dropped every 5’, then in a Corridor Design Stage where the multiplier was set to 10, the template would be dropped every 50’.

Include Critical Sections
[image: ]
This section allows the inclusion or exclusions of various critical sections within a design stage. For example, in a preliminary or conceptual stage you may want these disabled, while in a final design stage you would of course want them enabled.

Display Settings
[image: ]
When a corridor is built, there is a graphical element handler that is placed into the dgn file that allows you to graphically grab and edit the corridor. These settings allow the user to control the display of this graphical corridor element.
One good rule of thumb is to create these graphic elements as construction elements.

Output Settings
[image: ]
These properties allow you further control of the model display. For example, you can create a single mesh element, both of the top and bottom of the model, in order to create a single terrain that can be used for a variety of purposes (volumes, machine control, contour display, etc.). In addition, you can control whether the linear features and the component meshes are created as well.

[bookmark: _Toc352232074]Linear Template Design Stages
Similar to Corridor Design Stages, these settings allow an organization to specify different design stages for a linear template, then apply particular preferences for each design stage. For example, in a conceptual or design stage, we may not want to create the mesh elements, yet in a final stage we would of course want them on.
The Bentley-Civil-Imperial workspace delivers 2 Linear Template Design Stages: Design and Final w/Meshes. 
Each Linear Template Design Stage includes the following properties.
Display Settings
[image: ]
When a linear template is applied, there is a graphical element handler that is placed into the dgn file that allows you to graphically grab and edit the template. These settings allow the user to control the display of this graphical element.
One good rule of thumb is to create these graphic elements as construction elements.
Output Settings
[image: ]
These properties allow you further control of the model display. For example, you can create a single mesh element, both of the top and bottom of the model, in order to create a single terrain that can be used for a variety of purposes (volumes, machine control, contour display, etc.). In addition, you can control whether the linear features and the component meshes are created as well.
[bookmark: _Toc352232075]Survey
When processing survey data, there is a variety of settings that need to be addressed by a user in order to have the data processed properly. The Survey Settings allow an organization to pre-configure these settings for various types of survey processing. For example, you could have one set of preferences for Raw data and another for ASCII data.
Each Survey Setting includes the following properties.
General Settings
[image: ]
These are basic general settings that cover the processing of the survey data.
Points
[image: ]
This section allows the specification of how the coordinate records are to be imported as well as which features are to be treated as Control Points.
Linking Codes
[image: ]
This section deals with all the preferences regarding linking codes.



Data File Parsing
[image: ]
This area has preferences regarding how to interpret and parse data files.

Least Squares Defaults
[image: ]
This section has all the property settings for Least Squares Adjustments.

Elements Symbology
[image: ]
When visualizing observations, control points and setups, these property allow for the control and display of these objects.





Terrain Model
[image: ]
When processing Survey, these settings control not only whether the terrain is created or not, but also the attributes and display of the terrain.

[bookmark: _Toc352232076]Review Project Settings
Objective:
In this exercise we are going to review the Project Settings that are delivered in the Bentley-Civil-Imperial workspace.
Procedure:
1. Open the file Project_Settings_Imperial.dgnlib.  
1. Open Project Explorer and select the Civil Standards tab.
1. Expand the Project Settings tree as shown.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLf258969.PNG]

1. Right-Click on any of the Corridor Design Stages and select Properties in order to review the available settings.
1. Right-Click on either of the Linear Template Design Stages and select Properties in order to review the available settings.
1. Open the file Survey_Feature_Definitions_Imperial.dgnlib.
1. Expand the Project Settings tree as shown.

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTMLf293783.PNG]

1. Right-click on the Default Settings for Survey and select Properties in order to review the available settings.
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1. 
[bookmark: _Toc352232077]Chapter 11:	Civil Cells
[bookmark: _Toc352232078]Overview
Civil Cell Overview
A civil cell is a collection of civil elements - geometry, templates, and terrain models - which can be placed repeatedly in a design. The collection of civil elements will have been created relative to one or more reference elements. When you place the civil cell, you choose the new reference elements, and a new collection of civil elements is then created relative to them. A civil cell can therefore be thought of as a copy of the original collection of civil elements, relative to the geometry of the new reference elements. Civil cells can be 2D or 3D. They can consist of 2D (plan) elements only, or 3D elements (2D elements with profiles), and can include terrains, linear templates, area templates, and simple corridors.
When the new civil elements are created, all of the rules associated to them are also created. This means that the new civil elements retain their relationships, both with each other and with the reference elements, and therefore know how to react when these relationships change. In addition, the Civil and MicroStation toolsets can still be used on the new civil elements, to adjust and further refine the design as required, because there is no difference between a civil element created by a civil tool, and one created by placing a civil cell.
Civil cells can save a lot of time and effort, because they replicate the complete series of steps needed to create the civil elements. They also help to ensure compliance with design standards, by making a civil cell available to the design team.
Examples of Use
A civil cell can be used to recreate any well defined collection of civil elements. Common examples of where civil cells could be used include:
· Traffic islands and pedestrian refuges
· Driveways and accesses
· Traffic calming features
· Lay-bys
· Intersections
· Turning heads / court bowls
· Merging and diverging ramps
· Building pads
· Roundabouts


Sharing Civil Cells
While civil cells can be created and placed in the current DGN, it is likely that you will want to use them in different DGNs, which could represent different parts of the current design, or a different design entirely. For ultimate flexibility, create your civil cells in a library file (DGNLib).
Configuration Variables
A configuration variable can be used to point to the location of your Civil Cell DGNLibs.
Example:
CIVIL_CIVILCELLDGNLIBLIST > $(_USTN_PROJECTDATA)/dgnlib/Civil Cell Examples/*.dgnlib
CIVIL_CIVILCELLDGNLIBLIST > $(_USTN_PROJECTDATA)/dgnlib/Civil Cell Examples /example civil cell.dgnlib
If this variable is NOT set or the specified DGNLib file is not found, then the process looks inside each DGNLib specified by the MS_DGLIBLIST variable and lists any that contain civil cells.
If this variable IS set and the DGNLIb(s) is found, then only this DGNLIB(s) is used to list the civil cells. In other words, if this file contains other civil items (such as feature definitions or project settings or filters), they are ignored.

C:\ProgramData\Bentley\PowerGEOPAK V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\Civil_Cells\

C:\ProgramData\Bentley\PowerInRoads V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\Civil_Cells\

[bookmark: _Toc352232079]Review Civil Cells
Objective:
In this exercise we are going to review the Civil Cells that are delivered in the Bentley-Civil-Imperial workspace.
The DGN Libraries used in this exercise are located as follows:
GEOPAK

C:\ProgramData\Bentley\PowerGEOPAK V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\Civil_Cells\
InRoads

C:\ProgramData\Bentley\PowerInRoads V8i (SELECTseries 3)\WorkSpace\Projects\Examples
\Bentley-Civil-Imperial\dgnlib\Civil_Cells\


Procedure:
1. Open the file T-Intersections.dgnlib.  
1. Select one of the Civil Cells and rename it. 

This can be done through either the Context toolbar or MicroStation Element Information dialog.

1. Expand the Civil Cells tree as shown. 

[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML11bad3a0.PNG]

1. Rename the References as follows:

Secondary Rd CL  Side Road Centerline
Thru Rd EP  Mainline EOP
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[bookmark: _Toc349908238][bookmark: _Toc352232080]Learning Paths
All of our training through Bentley is accessible via learning paths, ready-made training plans that provide the recommended progression of skills training for a product, solution, job role, or experience level. 
In developing your team, you can choose from Bentley-recommended learning paths or configure your own to meet your teams specific needs. 
Learning paths help us:
· Develop our internal talent pool
· Make our employees more productive 
· Prioritize learning topics by what is important to us as a company
· Reinforce our corporate culture of continuous learning
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Learning Paths



[bookmark: _Toc349908239][bookmark: _Toc352232081]Assessment
1. True or False, when setting up seed files to include the desired civil settings and preferences, this is done within MicroStation.
True - The Design File Settings dialog (Civil Formatting) and the Workspace Preferences dialog (View Options – Civil) are all accessed from within MicroStation.
44. The Project Explorer dialog is used to link to your legacy settings. Within which tab in the Project Explorer dialog would you find this functionality?
_X_ Civil Standards
___ Survey
___ Civil Model
There are three types of features that are supported in Bentley Civil SELECTseries 3. Which of the following is not a valid civil feature?
___ Linear
___Point
_X_ Pipe
___ Surface
4. 	What MicroStation functionality is used to allow you to propagate your civil standards across your organization?
___ Cell Libraries
_X_ DGN Libraries
___ Font Libraries
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[bookmark: _Toc257190045][bookmark: _Toc316480965][bookmark: _Toc352232082]Appendix A:   Setting Up the Workshop in Your Office
[bookmark: _Toc352232083]Overview
Since this workshop is designed to be run within the confines of the delivered “Bentley-Civil-Imperial” workspace, it can easily be set up to run on your office computer or laptop.  
[bookmark: _Toc352232084]Exercise:  Copy the Dataset from DVD to Your Computer
Note that many of the workshops use references files and other resources that are path- dependent.  Therefore, you may want to utilize the same path as you did in the actual workshop. 
[bookmark: _Toc316480826][bookmark: _Toc316480908][bookmark: _Toc352232085]Exercise:  Setup Workspace
1. Double-click on the appropriate Bentley Civil product on your desktop.
1. In the File Manager dialog, set the following:
Users > Examples
Project > Bentley-Civil-Imperial
Interface > Bentley-Civil
Refer to Chapter 1 and you are ready to go.
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[bookmark: _Toc308648766][bookmark: _Toc257190049][bookmark: _Toc352232086]Appendix B: Export to Native 
[bookmark: _Toc352232087]Overview
“Export to Native” is a functionality within Bentley Civil V8i SELECTseries 3 that allows the user to keep a version of the native geometry database (.GPK, .ALG, .FIL) in synch with the new civil geometry stored within the design file. As a simple example, with this option enabled the user can store an alignment in the design file and that alignment will be automatically stored in the native geometry database as well. Delete that alignment from the design file, and that alignment will be deleted from the native geometry database. 
“Export to Native” is not designed to work as an ‘all or nothing’ functionality. It is feature based in that the option to “export to native” must be set to “true” or “false” for each particular feature. For example, an organization may want all civil geometry stored with the feature “Centerline” to be exported to the native geometry database. But for other features (e.g. ““Edge of Pavement”, “Toe of Slope”, “Existing Drainage”, etc.) the organization may not wish to have these features exported.
[bookmark: _Toc352232088]Description
In this appendix, we’ll explain how “Export to Native” works and how to set it up. In addition, we’ll look at the functionality in more detail so that an organization will have enough information to decide on whether to implement or not. 
Note that the functionality we are going to describe, as well as its setup and best practices, for the most part works the same in GEOPAK, InRoads and MX. The main difference of course is how each product originally links to its own native feature files (.DDB, .XIN, .PSS). See Chapter 5 for instructions on how to link up to the native feature files. However, where there are differences in functionality between the products we’ll point that out.
We’ll look at four areas with the regard to the “Export to Native” functionality:
	Why Export to Native?
Setup
	How it Works
	Best Practices 
[bookmark: _Toc352232089]WHY EXPORT to Native?
Keep in mind that in Bentley Civil V8i SELECTseries 3 there are older applications (e.g. Labeling, Sheet Clipping, etc.) that will continue to rely on the native geometry databases (.GPK, .ALG, .FIL). The “Export to Native” functionality allows the native database to be created and kept in synch ‘automatically’ – forgoing the need for a user to manually export to the native database.
[bookmark: _Toc352232090]Setup
Once the link has been made to the native feature files, we can review each feature and its associated settings from Project Explorer. Although there are several tabs (Survey, Plan, 3D, Cross Section, Profile, etc.) that allow an organization to control how this feature will be displayed in each of these areas, only two allow the enabling of the “Export to Native” functionality via the “Auto Export” option – the Plan tab and the Profile tab.
As shown in the following image, these tabs have the options to either enable (set to True) Auto Export or disable (set to False) Auto Export.
[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML25510bf5.PNG]
In the particular instance of the feature “Centerline” shown in the dialog above, the Plan tab would of course tell the software to Export any horizontal geometry stored with this feature to the native database. The Profile tab would perform a similar function for any vertical geometry stored with the feature “Centerline”.
Note: By default, the Auto Export option is set to “False” for each feature. It is incumbent upon an organization to decide which features if any are to be exported and then enable the option for those particular features only.
[bookmark: _Toc352232091]How it Works
Now that we’ve seen how to enable or disable the Auto Export option for any particular feature, let’s take a look at how it works in practice. 
New Geometry
Whenever new civil geometry is stored in a DGN file using a feature that has the Auto Export option enabled, a ‘copy’ of that geometry is automatically exported to (or stored in) the native geometry database. This is probably the simplest case of the Export to Native functionality and the easiest way to explain how it works.
Modified Geometry
Let’s say that you have some existing civil geometry in a DGN file that has been previously Exported to the native database. Now you make changes to that geometry. For example, you could change a radius or rename it. Whenever these changes are made, the corresponding change is made to the geometry in the native database in order to stay in synch.


Deleted Geometry
Similar to the case of the modified geometry, let’s say that you have some existing civil geometry in a DGN file that has been previously Exported to the native database. Now you delete that geometry. When you do that, the corresponding deletion is made to the geometry in the native database in order to stay in synch.
One-Way Only
Keep in mind that this synchronization is a one-way street only. What that means is that while changes to civil geometry in the DGN file are Exported to the native geometry database, the functionality does not operate in reverse. In other words, any changes made to the native geometry database are NOT automatically carried back to the civil geometry in the DGN file.
[bookmark: _Toc352232092]Best Practices
Finally, let’s review some things that an organization will want to consider when implementing the Auto Export functionality within Bentley Civil V8i SELECTseries 3.
Naming Conventions
If your native geometry database has any naming conventions (e.g. no spaces, character limitations, etc.), then you will want to keep this in mind when naming civil geometry. Any geometry not meeting the conventions of the native database will not be Exported as desired.
Copying Design Files Containing Civil Geometry
When civil geometry is Exported, there is a ‘rule’ that tells that piece of geometry that it needs to stay in synch with the native database. The ‘rule’ is stored with the geometry itself and does not rely at all on the design file itself. Therefore, any changes made to the ‘copied’ geometry would still be Exported to the native database.
For example, let’s say that you made a new file by copying an existing design file that had Exported civil geometry elements in it. Now let’s say you deleted the civil geometry from that new file. When you do that, the changes would be Exported to the native database and all the corresponding geometry there would be deleted as well.
Manual Export
If an organization chooses NOT to implement the Auto Export functionality, keep in mind that a user still has the ability to Export or “export” the civil geometry manually at any time. This can be done with the Export Geometry tool.
	General Geometry Panel
	Icon
	Tool

	[image: C:\Users\DERRIC~1.GRA\AppData\Local\Temp\SNAGHTML29d46c45.PNG]
	[image: ]
	Export Geometry
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[bookmark: _Toc352232093]Appendix C:  Civil Report Browser
[bookmark: _Toc352232094]Overview
The Civil Report Browser is utilized throughout Bentley Civil to generate and print reports on geometry, corridors, superelevation and a myriad of other topics.  Default reports are included within the installation; however, each organization may want to review the reports to determine:
Is the default report the desired report or is there another report that is better suited?
Does the report need customization to include different data, formatting, etc.?
[bookmark: _Toc352232095]Accessing the Browser
While the users access the browser from the report tools, support staff and those creating / editing reports may access the report browser from outside the product.  It is located at:
..\PowerGEOPAK\RoadWayDesign\bin  
..\PowerInRoads\RoadWayDesign\bin
It’s an executable file:  ReportBrowser.exe.  
[image: C:\Users\LOU~1.BAR\AppData\Local\Temp\SNAGHTML45a58b0.PNG]


[bookmark: _Toc352232096]Setting the Defaults
Setting the Defaults is accomplished within the Report Browser.
[image: ]


[bookmark: _Toc352232097]Appendix D:  MX Workflows
[bookmark: _Toc352232098]Overview
The MX model file provides a single file location where the MX Models are contained, this practice difference from InRoads and GEOPAK that have external files for separate model. This practice affords the MX user some benefits and negatives that as we move towards the new civil tools need to transition the benefits and address the negatives with the new tools.
Typical MX workflows revolve around a structured input file design approach. To aid in the adoption of the new tools additional processes have been implemented to aid in the transition and integrate traditional MX workflows with the new civil tools.
The processes described are specific to MX and require being in an active MX project.
[bookmark: _Toc352232099]Dealing with MX models and Civil Features
Since the MX model file contains many models we need a way to define the active MX model and pick the appropriate MX features for it. This is achieved by way of enhancing the standard feature toolbar with a MX model control. 
Without an active model the Feature listing reports civil features appropriate to the MX PSS. The MX PSS needs to have been imported to civil features and this is covered in an earlier chapter.
If no MX model is present the feature list reverts to the configuration variable 
MX_DEFAULTCIVILSTYLESET=publicstyles/mxroad.pss 
 for the default MX styleset and provides corresponding features  from that to the civil feature definitions.
The processes associated here are very similar to the MX conversion toolbar for converting CAD graphics to MX string features.
[image: C:\Users\IAN~1.ROS\AppData\Local\Temp\SNAGHTML11ef338b.PNG]
MX Feature Toggle Toolbar


[bookmark: _Toc352232100]Importing MX Geometry
The MX model.fil is the single file source for MX models / strings. To simplify the file import geometry process the MX user has the option to import directly from the active projects model file.
[image: ]
Import Geometry from Active MX model
As MX designers we tend refer to Alignments in MX as Master Strings, the reality is the MX geometry in its pure form is stored as G Strings, with M Stings essentially holding the chained / stroked point information associated with the GString, with the two linked by their sub references. 
When importing MX geometry to new tools treat M and G strings separately. Importing 
· G Strings as Alignments with Profile
· M Strings to 3D linear elements
[image: C:\Users\IAN~1.ROS\AppData\Local\Temp\SNAGHTML1197f4d5.PNG]
Import Geometry from Active MX model
Civil Geometry supports multiple profiles per alignment, with only the active profile being used in the creation of the 3D DGN model. The MString profile if holding modified profile over the Gstring can be referenced and set as the active if required.
All geometry transactions between MX and Civil are recorded to the MX project log file 
[bookmark: _Toc352232101]Export of MX Geometry
During the export of geometry to MX (manual or automatic) only the ‘Active’ civil profile is exported to MX. The respective M & G Strings are automatically created in conjunction with the corresponding linemode for horizontal (Halgn) and vertical (Valgn / Verat). The respective linemode code is written to the MX log file and associated ASCII files are created in ..\mediate\ folder. These input files can then be incorporated back into the the existing input file process.
[bookmark: _Toc352232102]MX Log file
The MX log file records transactions with the MX Engine and provides a source to develop the input file workflows. To aid in transitioning workflows to Civil Geometry the transactions to import from MX and export to MX are recorded in the log file.
[bookmark: _Toc352232103]Major Option Script
Major option script has been enhanced to support more CAD orientated workflows, allowing attachment of reference files (introduced in SELECTseries 1) and further enhancements for SELECTseries 3 to accept MSTN keying and Civil commands.
The import geometry process is captured and written to the MX log file for each string imported in the following format.
script, geomcmd import model=MX TUTORIAL GROUND name=GC10
This command can be put used in the design input file process to facilitate displaying the MX  geometry as Civil Geometry and so provides a means of bringing legacy projects held in input files into the dynamic modeling environment provided at SELECTseries 3.

[bookmark: _Toc352232104]Import Terrain Model
During the import of MX models to Civil Terrains the corresponding command line record is written to the log file. This allows a MX user to convert MX models to Civil Terrain models where they will benefit from display and analytical performance enhancements.
script,dtmcmd import model=GROUND MODEL edgemethod=RemoveMaxSide maxsidelength=50 featuredefinition=Existing Ground
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[bookmark: _Toc352232105]Glossary
	2D Point Feature
	Contains no elevation (Z).  2D Point Features are defined and stored in plan model.

	3D Geometry
	3D geometry is created in 3D model by mathematically combining the horizontal and vertical geometry to create 3D elements.  These 3D geometry elements in turn define a design model.

	3D Model
	This is created and managed automatically.  User can interact with it but this is not usually required.  The mathematical combination of Plan Geometry and Profile Geometry is stored in the 3D model.

	3D Point Feature
	3D points can be defined in plan model or 3D model.  They are stored in 3D model but represented in both plan and 3D.

	Active Object
	The current object to which is added all geometry which is created.

	Active Profile
	Of the multiple possible profiles for an element, the active profile is the one used for design.  The active profile is combined with the horizontal geometry to build a 3D element which is used in the 3D model.

	Active Terrain Model
	One terrain model can be designated as “Active”.  The active terrain model is the one used to display “existing ground”; in other words the one which displays automatically in a profile model when it is opened.  The active terrain model is also the one which is targeted by side slopes unless the template defines a different target by name.

	ALG
	A legacy (proprietary) InRoads file containing coordinate geometry information, superelevation, and alignment information for a specific geometry project.

	Alignment
	A linear feature which serves the special purpose of defining the centerline or baseline of a roadway.

	Apply Linear Template
	Applies a corridor template along a feature while hiding some of the complexity of creating a corridor.

	Apply Surface Template
	Applies a corridor template to a terrain model for the purpose of creating components (such as pavement layers) under the terrain model.

	Arc Definition
	Curve definition method generally used in roadway applications. The radius R is used to define the curve and is defined by the equation R=5729.58/D where the degree of curvature D is the central angle subtended by a 100-foot arc.   Set in the Design File Settings > Civil Formatting under Radius Settings.  See also Chord Definition. 

	Aspect
	An angular measure of the direction that the face of a surface is oriented. The format of the value is dependent on angular settings In the DGN file.

	Base Geometry
	In many instances the geometry element will be trimmed. The original (or base), untrimmed element is always preserved as it is the storage for the rule.

	Boundary  (Terrain Model) 
	Used to constrain the external boundary of the terrain model. No triangles are created outside the boundary. In addition, any point data outside the boundary is ignored.

	Break Line
	A surface feature consisting of a collection of spatial coordinates that have an implied linear relationship. No triangle side (in the triangulated surface) can cross over a break line.

	Break Void
	A closed area of missing or obscured data that uses the elevations of each vertex, while the void lines between successive void coordinates are inserted as break lines. Therefore, break voids change the slope and elevations of the TIN surface.

	Cardinal Points
	One of the points used to define the geometry of an alignment. Cardinal points include PC, PT, PI, and CC points for horizontal geometry and VPC, VPI and VPT for vertical geometry. 

	Centroid (triangle)
	Geometric center of a triangle in a terrain model. 

	Chord Definition
	Curve definition method generally used in railway applications.  The radius R is used to define the curve, and is defined by the equation R=50/SIN(0.5*D) where the degree of curvature D is the central angle subtended by a 100-foot chord.  See also Arc Definition. 

	Civil Cell
	Used as a mechanism to preconfigure commonly used complex geometric layouts.  These layouts will commonly be stored in DGNLIB files for reuse across multiple projects but it is possible and sometimes useful to store directly in an active DGN file for use in that single location.  The civil cell will contain horizontal geometry and can also contain the vertical geometry.

	Civil Message Center
	Used to display a continuous updating log of Civil messages, including warnings and errors. As errors and warnings are resolved, they are removed from the list.  New messages are added whenever the conditions warrant. Most messages relate to civil geometry, superelevation, and corridor modeling.

	Civil Template
	A civil design concept used most often for corridor modeling but also has other applications.  The Civil Template defines the cross-sectional shape of the object being modeled.  This cross-section is then “extruded along” a 3D geometry element to form the final model. The corridor template can create or target features such as road edges.  The result is the creation of a corridor.

	Clipping Reference
	Clipping allows you to remove areas of overlap when working with multiple corridors in a single surface.  For example, in a corridor intersected by a crossing roadway, clipping would be used to remove all overlapped features within the intersection.

	Complex Terrain Model
	A terrain model created by merging or appending two or more terrain models. 

	Context Toolbox
	When an element is selected, hovering over the element provide a heads-up and context sensitive toolbar which pops up at the cursor.  This toolbar provides a few of the most commonly used tools which operate on the element selected element type. The first tool in this toolbar is always Quick Properties.

	Contour
	A linear symbol representing points of equal elevation relative to a given datum.

	Contour, Isopach
	Contours of a delta terrain model which represent cut and fill values as contours, not elevations. A positive contour represents fill, while a negative contour is cut.  

	Contour, Major
	The primary elevation line indicating a specific elevation in a surface model. Usually major contours are drawn with a heavier line weight or using a different color. Elevation text labels are usually drawn in association with major contours.

	Contour, Minor
	A secondary elevation line indicating a specific elevation in a surface model. Minor contours are often drawn without special color or weight indexing and without elevation text labels.

	Corridor
	A civil object used for modeling a roadway and is automatically managed by the corridor modeling tools.

	Cross Section Model
	DGN models (extracted perpendicular to defined horizontal geometry) with special station elevation coordinates defined and other specialized capabilities such as view exaggeration. Cross section stations match the interval in the template drop when a corridor is used as the basis. When horizontal geometry is utilized, the left / right offsets and interval are user-defined.

	Curve Stroking
	Stroking is the process of automatically adding shots to the terrain model or corridor by interpolating new shots from the curved sections of the data. This distance is used to interpolate new shots along the curved element in corridor processing and applying linear templates. This value is used as a perpendicular minimum distance from chords generated along the arc. Chords are drawn along the arc and the perpendicular distance is measured from the middle of each chord to the arc. If this distance is larger than the Curve Stroking, the process is repeated with a shorter chord length. This process is repeated until the end of the curve is reached. The flatter the curve, the fewer number of points will be calculated. The steeper the curve, the greater number of points that will be calculated.

	DDB File
	GEOPAK file (Design DataBase) which contains features definitions, associated symbology and annotation settings. 

	Delta Terrain Model
	A surface containing data derived from the difference in elevation between two terrain models or a terrain model and a plane. 

	Dialog
	The tool settings box for the active command.  The dialog shows all available options for a command.  For most civil commands, most of the time, the dialog can be hidden and ignored since the user is given all necessary instruction and inputs by way of the cursor prompt.  The dialog is necessary for configuring command customizations.

	Drape
	The process of vertically projecting elements onto a surface so that the element elevations are defined by the surface.

	Drape Void
	A closed area of missing or obscured data where the void coordinates are not included in the triangulation. Voids are inserted post triangulation. The void coordinates and lines are draped on the TIN surface. Even though a user must provide an elevation for the Drape Void vertices, the user elevations are changed to the elevation of the TIN surface at the XY Drape Void coordinate position.

	Element Template
	MicroStation concept which allows preconfigured definitions for symbology and other miscellaneous display of MicroStation elements and civil features.

	End Condition
	A specialized component of a corridor template which provides information tie into active surface.

	End Condition Exception
	Used to modify the behavior of an end condition solution without requiring the use of additional template drops.  When an end condition exception is added, it must be edited to change its behavior.

	Export to Native
	Option to automatically or manually push horizontal and vertical geometry into native products (InRoads - ALG, MX - PSS and GEOPAK - GPK).  

	Feature
	A Feature is anything that can be seen or located and is a physical part of your design, representing a real world thing.   A feature’s definition is one of its properties.  At any given time in the design process, the feature will have a Horizontal Geometry, a Vertical Geometry, 3D Geometry or a combination to define its location.

	Feature Definition
	Used to define options when creating features.  These are the items which are created in advance, usually used across multiple projects and define symbology, annotation and quantities.  The feature definition is assigned (usually) in the plan model and profile/3D feature definitions follow from there.

	Feature Name
	Each Feature can have a name.

	Gap
	When a feature is trimmed the part(s) which are invisible on the base geometry.

	GPK
	A legacy (proprietary) GEOPAK database containing coordinate geometry information.

	Graphical Filter
	Using in developing terrain models, an automated way of storing search settings for graphic elements when creating terrain models using 3D element. A graphical filter can be created for each feature (i.e., spots, breaks, voids) then the filters can be defined as a Graphical filter group.  

	Heads Up  Prompt
	Command instructions are given in a heads up and dynamic prompt which floats at the cursor.

	Horizontal Geometry
	The elements which define the horizontal layout of the design.  These elements are 2D elements even if the DGN model is 3D. Horizontal Geometry may be points, lines, arcs, spirals, splines or any combination in a complex element.

	Interval
	When a feature is trimmed the part(s) which are visible on the base geometry.

	Island
	Closed area used to place within a void, i.e., islands in the middle of rivers, lakes, etc.

	Key Station
	Additional station added to the corridor to force processing at the particular location. 

	LIDAR
	(Light Detection And Ranging) is an optical scanning technology which scans ground and other physical features to produce a 3D model. 

	Linear Feature
	In plan model, composed of lines, arcs, spirals, splines or combinations of these.  In profile model, composed of lines, parabola, splines or combinations of these.

	Linear Stroking
	Stroking is the process of automatically adding shots to the terrain model or corridor by interpolating new shots from the linear sections of the data.  Linear stroking is measured along the element.  Interpolated vertices are added whenever the distance between the vertices is greater than the linear stroking value (in master units).

	Manipulators
	The heads up, on-screen editing interface.  Only the most common properties are presented in manipulators.  Manipulators are in two types:  graphical and text

	Overlay Vertical Adjustment
	Within Corridor Model, tool used to develop a vertical geometry (based on milling and overlay parameters) and apply to the corridor.

	Parametric Constraints
	Used to set up constraint value overrides for specified station ranges. 

	Plan Model
	The usual DGN model, used for laying out horizontal geometry.  Best practices will dictate that this is a 2D DGN model but 3D DGN model can be used.  This is where geometric layouts and corridor definitions are kept. The geometric layouts are not only alignments but also edges, parking, striping, sidewalks, etc.

	Point  Features
	Defined by a single X, Y  (Z optional) location. A point need not be a feature.  It may be defined as a non-featurized point by way of AccuDraw, Civil AccuDraw, Snap or a data point.  Non featurized points are use to control the construction of Linear Features.

	Point Cloud
	A set of vertices in a 3D coordinate system and these vertices are defined the by X, Y and Z coordinates. Point clouds are usually created by 3D scanners. These devices measure a large number of points on the surface of an object and output a point cloud as a data file. The point cloud represents the visible surface of the object that has been scanned or digitized.

	Point Control
	Used to modify the behavior of points in a template. These controls take precedence (they override) over existing constraints on the point.

	Project Explorer
	MicroStation's interface for browsing elements in a DGN file.  Extended by civil to accommodate specialized civil needs.

	PSS File
	MX file (Plans Style Set) which provides the graphical representation for the MX string features. 

	Reference Element
	The rule for some geometry is a calculation from another element.  This other element is the reference element.

	Secondary Alignment
	Used to modify the direction of cross section processing.  By default, as any given station, the cross section is created orthogonal to the main alignment/feature.  If a secondary alignment exists, then that portion of the cross section which lies outside the secondary alignment will be orthogonal to the secondary alignment instead of the main alignment.

	SEP File / Method
	Uses the superelevation settings which originated in GEOPAK.

	SMD File
	GEOPAK file (Survey Manager Database) which contains survey features definitions and associated element and textual settings. 

	Spot Elevation
	A set of X, Y, Z coordinates representing a point on the terrain model surface. There is no implied relationship between regular points.

	SRL File / Method
	Uses the superelevation settings which originated in MX

	Superelevation Lane
	The closed area defined by the superelevation tools used for the limits of transition calculations and pivoting location. 

	Superelevation Section
	Area along a horizontal geometry element, where superelevation will be calculated.  

	Target Aliasing
	Used to create the desired results when working with multiple surfaces without having to edit the template from the template library.  Target aliases can also be used so that one corridor can target the solution of another corridor.

	Template Drop
	An area (usually defined by station limits) along a corridor to which a specific template is applied. 

	Template Library
	A file that stores definitions for templates, generally with an ITL file extension.

	Template Transition
	The transition indicator occurs in the corridor between templates of differing names.

	Terrain Model
	A three-dimensional DGN element defined by spots, break lines, voids, holes, contours to model a surface on the earth.

	Tooltips
	When hovering the cursor over an element or a handle, a tooltip is shown which gives explanatory information.

	Trace Slope
	Upstream - The indicated path follows the steepest ascent from a user-defined point through the terrain model terminating at a high point or the edge of the terrain model. 
Downstream - The indicated path follows the steepest descent from a user-defined point through the terrain model terminating at a low point or the edge of the terrain model.

	Vertical Alignment
	A linear feature in profile model which serves the special purpose of defining the elevations of an alignment.

	Vertical Geometry
	The elements which define the vertical layout of a corresponding horizontal geometry element.  These vertical elements are 2D and are stored in a profile model.

	Void
	Closed shape to demarcate areas of missing data or obscure areas. No point or break data located within the void area is utilized and no triangles are created inside the void areas. The Void coordinates are included in the triangulation and void lines between successive void coordinates are inserted as drape lines on the surface. Therefore, they do not change the slope or elevations of the surface.

	Watershed
	Defined by either a low point within the terrain model or a low edge point along the terrain model edge, it's the closed area wherein all water would drain to the low point. 

	XIN File
	InRoads file which contains features definitions, associated styles, annotation, and other settings. 
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